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Last Updated 8/1/2007 

Morphbank offers a service called delivered uploading that uses this prepared 
data entry workbook.  Submitters can enter and then deliver to morphbank, the 
workbook populated with information.  

The Data entry workbook is an Excel file which consists of eight worksheets 
titled: Image Collection, Images, MyView, Specimen, SpecimenTaxonData, 
Locality, External Links and Supporting Data. Their names are correlated with the 
names used in the morphbank Database. When a cell in each of the active 
columns is selected, a short description of the expected data is given. This guide 
will provide a more detailed description for each of the columns and how they 
should be populated. 

 
 

 
Data  Preparation:  Data Preparation:
  
Before beginning the process of entering data into the workbook there are 
preparation details that will facilitate this process. 
 
Users should only release data into morphbank that is appropriate for world-wide 
release. For example, if an image of an endangered or protected specimen 
includes annotations as to its specific locality, that information should be masked 
before sending the image to morphbank.  When propagating the locality section 
of that specimen, care should be taken to avoid precise locality details (i.e. enter 
the collection county as opposed to the exact area within that county where the 
specimen was collected.  In these circumstances, users can enter contact 
information in the Information Withheld column of the Locality sheet for other 
users to obtain the withheld data if needed. 
 
Before entering data into the workbook, the user will need to have available the 
following information. 
 

• It is preferred that a valid morphbank username and password is acquired 
prior to submitting the workbook (obtained through the login screen 
(upload) at www.morphbank.net  or by contacting the morphbank admin. 
group at mbadmin@scs.fsu.edu).  If the user does not have an account 
before submitting the workbook, one will be generated at that time. 

• General information about your collection of images to include the 
contributor (person with authority to release image), release date, 
morphbank user group to which the images should be attributed and a 
project link (if one exists) to which the images are related.  
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• Locality details to include continent/ocean, country, and locality description 
(region, province, county and place). 

• Information about the specimen and the parties involved in the collection 
of it to include basis of record, sex, developmental stage, form, 
preparation type, number of individuals collected or observed, type status, 
family, collector’s name, date collected, locality. 

• Taxon name data for the specimens needs to be checked in the 
morphbank database and names not in the morphbank system will need 
to be added via the web and/or this spreadsheet. 

• Information about the view of the specimen to include specimen part, view 
angle, imaging technique, preparation technique, developmental stage, 
sex, form, name of the highest taxon to which this view is applicable. 

• Images in the collection and information pertaining to them to include 
specimen description, view name, image file name to be uploaded.  The 
images sent to morphbank must be one of the following image types: 

1. Bitmap [.bmp] 
2. Joint photographic experts group [.jpeg, jpg] 
3. Tag information file format [.tiff]) 

--tiff images are best saved as RGB color and NOT indexed color, 
or CMYK color mode 
--tiff images generated from a Philips SEM system need to be 
modified to appear correctly in morphbank.  See warning note 
below. 

Photoshop (psd) images should be flattened and saved as one of 
the image file types above.  

 
 
 
 
WARNING:  Philips SEM users 
 
Image Display Problem:  
Philips SEM machines utilize non-square shaped pixels so when the 
images are outside of Philips software they are distorted slightly.   
 
To Fix: 
The images need to be resized from 1424X968 to 1424X1064 for high 
resolution images and 712X484 to 712X532 for standard resolution.  
Philips has a small conversion program called XL-Stretch or images 
can be resized manually with image manipulation software such as 
Photoshop.    
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Note:   
The above listed information is only the minimum needed to 
successfully submit data into the morphbank data entry workbook. It 
is with great emphasis that we suggest all applicable data fields be 
completed.  This will improve the reliability and accuracy of data 
searches within the morphbank database.  
Additionally, great care should be taken to make sure all entries are 
as complete and precise as possible.  Inaccurate workbook pages 
require corrections, which will mean delays in importing the data to 
the database. Numerous inaccuracies in the submitted workbook 
may result in its return to the submitter for review and correction. 
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Data  Entry  Strategies:  Data Entry Strategies:
  

• Organization folder-It is helpful to place all the images that will be 
uploaded to morphbank together in a folder on your machine.  The 
organization of the images in this folder will influence the order of 
the image data input into the excel spreadsheet.  Having these 
images efficiently organized before entry (e.g. images relating to 
the same taxon or the same body structure, etc.) will reduce 
frustration and mistakes during data input.  

 

 
 

Figure 1 Anatomy of a Workbook Page 
 

• Order of data entry- Once the taxon names have been checked 
and all other data is located and ready for entry, open the excel file 
and click on the Excel spreadsheet tab that corresponds to the area 
of the workbook you would like to propagate (see Fig. 1).  The 
preferred order for entering data into the morphbank data entry 



 

workbook is ImageCollection, Locality, SpecimenTaxonData, 
Specimen, MyView, Images, ExternalLinks and the Supporting 
Data page as needed.   

 
• Entering image collection data-Select the ImageCollection tab 

first to enter general information about the collection of images. 
 

• Entering locality data-After entering the ImageCollection data, proceed 
to the Locality tab and fill in all the applicable fields.  These fields are 
linked to fields in other tabs so you will only have to enter unique Locality 
data once. Make sure data for Locality coordinates are in the decimal form 
given in the examples in the Locality section of this manual.  Note: Make 
sure there are no duplicated data in the cells that make up the Locality 
sheet. If this occurs, the search functionality of each of the fields is 
compromised.  There are many online resources for translating degrees to 
decimal.  One example is http://www.jeeep.com/details/coord/ 

 
• Entering specimen taxon data- After entering the Locality data, enter all 

the taxon names associated with the specimens and images to be 
uploaded. If names at rank higher than genus need adding to morphbank, 
there are options other than the spreadsheet. Names at rank of Suborder 
or lower can be added via the web interface. In the event names of rank 
higher than suborder need adding, contact mbadmin@scs.fsu.edu 

 
• Entering specimen data-After entering the Specimen Taxon Data, 

proceed to the Specimen tab.  Fill in the fields found here.  As in Locality, 
fields are linked to other tabs.  Drop-down menus are provided for many of 
the fields.  If an option you would like to input is not provided in the 
drop-down menu, proceed to Supporting Data tab and modify the 
contents of the category as necessary. 

Notice that Locality is a field here; this field links to the data entered in 
the Locality worksheet.  Choose the locality that suits the particular 
specimen you are working with (this is the reason why you filled in the 
locality data first).  If you have a lot of different taxa (which you likely 
will have), this tab is eventually going to have a great deal of data 
associated with it! 

 
• Entering view data- Next visit the MyView tab.  This worksheet is split 

into two parts. In the first part users can choose a view from a drop-down 
list made from existing views in morphbank.  Check to see that the views 
needed are listed.  If the views currently in the spreadsheet are not 
suitable for current needs, they can be added using the second part 
(bottom half) of this worksheet.    

 
• Entering image data-Next proceed to the Images worksheet.  This is the 

heart of the whole process, and quite possibly may be the place you 
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spend the most time.  Under Specimen Description, choose from the 
dropdown menu the specimen descriptor of the images you are going to 
input.  This links to the data in the Specimen worksheet, and that is why 
the Specimen data is populated first. Magnification, Copyright Information 
and Image File Name all have to be manually entered.  MyView Name, 
however, is a drop-down field, and is linked to the MyView worksheet. 
Make sure that the views needed are a part of this list.  If the view data 
was entered in the previous step and it is not on the list, a mistake was 
made on the MyView Worksheet.  Care needs to be taken to ensure any 
new View options are properly linked to the Image tab.  A final suggestion 
for this tab is in regards to the Image File Name; if data entered here is 
incorrect, it will be impossible for morphbank to link the metadata 
(specimen, locality, etc.) with an image.  Be sure what you enter here is 
accurate.  In other words, the filename of the image must NOT contain 
spaces.  The filename may_contain_underscores.  The image filename 
given in the spreadsheet must match EXACTLY with the image filename 
you upload to morphbank (to the website, to the ftp site or via CD/DVD).  If 
both uppercase and lowercase letters are used in a given filename, these 
must be the same in the spreadsheet.  

 
• Entering link data-This is the final step in the population of the 

morphbank data entry workbook.  This section of the workbook is for those 
users who want to cite links to the entered data (Specimen, Image, 
Locality or View).   

 
Note:  If changes are made to the location information you must 
manually update the changes to the specimen and image information.  
Changes made in one area of the workbook are not automatically 
reflected in other areas in the workbook. 

 
. 
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Image  Collection:  Image Collection:
 
 
The ImageCollection worksheet allows you to provide general information about 
your collection of images.  It should be the first tab selected in the data entry 
process. 
 

 
Figure 2 Image Collection Worksheet 

 
Contributor (Full Name)   

Enter the full name (first name and last name only) of the contributor of the 
images.  In morphbank the contributor is the person who possesses the 
authority to release the images.  
 

Contributor (Username)   
The contributor must be a morphbank user; if not, a username and password 
can be obtained online at www.morphbank.net (click on “help”) or by 
contacting the morphbank admin. group at mbadmin@scs.fsu.edu. 
 

Submitter (Full Name)   
Enter the full name (first name and last name only) of the person who 
prepared the data in Excel format and submitted it to morphbank for upload. 
They too must be a morphbank user. This can be done online at 
www.morphbank.net or by contacting mbadmin@scs.fsu.edu
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Release Date   
Enter the release date for the images if the images are not for immediate 
release to the public. The release date can be maximally five years from the 
date of inclusion of the images in morphbank. If you have different sets of 
images with different release dates, please create a separate Excel file for 
each image set. If you leave this field empty, we will assume that the images 
are for immediate release. The date must be entered in the form yyyy-mm-dd. 

 
Group   

Enter the morphbank user group to which the images should be attributed. If 
the images are not for immediate release, they can still be viewed and 
modified by the group of users to which you say they belong. By default, the 
images will belong to your private group, which only includes yourself unless 
you decide to add other users to it. Any other user group must be registered 
with the morphbank admin. group; contact the admin group if you need to 
register a new user group mbadmin@scs.fsu.edu. If you have different sets of 
images you want to share with other user groups, create a separate Excel file 
for each image set. 
 

Institution Name 
Provide an institution name (if applicable) for an institution associated with the 
data in the workbook.  
 

Institution Link 
Provide a link (if applicable/desired) to the above named institution.This link to 
the institution will be added as an external link to all the records created as a 
result of the provided data for upload. 
 

Project Name 
Provide a project name (if applicable) associated with the data in the 
workbook.  

 
Project Link 

Provide a link (if applicable) to the above named. This link will be added as an 
external link to all the records created as a result of the provided data for 
upload. 
 

Project Name 
Provide a second project name (if applicable/desired) associated with the 
data in the workbook.  

 
Project Link 

Provide a link (if applicable) to the second project named above. This link will 
be added as an external link to all the records created as a result of the 
provided data for upload. 
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Images:  Images:
 
The Images worksheet should be the last worksheet populated.  This is the heart 
of the data entry process and may take the most time.  The Images worksheet 
records information about the images in the collection. This worksheet has six 
columns. The explanation of how to populate them is given below.    

 

 
 

Figure 3 Images Worksheet 
 
Image Sequence Number  

A number that corresponds to the order of input made in the Images 
worksheet. This column is auto-generated. Do not change it. 
 

Specimen Description  
Choose a specimen description from the drop-down list, which is auto-
generated from the Specimen worksheet. If necessary, go to the Specimen 
worksheet to add new specimen entries. If there is more than one image for a 
given specimen, we recommend that you enter these images after each other 
so that they can easily be linked to the same specimen record. However, this 
is not strictly necessary, as long as you link all of the images to the correct 
specimen record. Note that the Specimen Description drop-down list only 
contains an abbreviated description of each specimen. If you have similar 
entries in the Specimen worksheet, make sure that you link each image to the 
right specimen entry. The easiest way to do this is to make sure that the first 



 

number in the Specimen Description, the specimen sequence number in the 
Specimen worksheet, is correct. 

 
My View Name  

Select the View describing the image from the drop-down list. The content of 
the drop-down list is taken from the View worksheet. The pre-specified views 
in the View worksheet are those contained in the morphbank system when 
your version of the upload tool was last updated by the morphbank group. If 
you need to add one or more new views to describe your images, simply add 
rows to the View worksheet. Your new view will be available to all users of 
morphbank after your data have been uploaded to the system. When 
choosing a view name from the drop-down list, please note that the list is 
sorted alphabetically on specimen part, so match this first before looking at 
the other data defining the view.  If the view data was entered in the previous 
step and it is not on the list, a mistake was made on the View worksheet.  
Care needs to be taken to ensure any new View options are properly linked to 
the Images tab. 
 

Magnification  
Enter a positive decimal number that corresponds to the magnification of the 
image. The magnification is calculated by dividing the size of an object as it 
appears on the image (when the image is rendered at normal or native size 
[100 %]) by the actual size of the object. Example: if the leg of the specimen 
is 0.5 mm long and on the image it appears to be 20 mm long, the 
magnification is 20/0.5 =40. Please make sure you specify the magnification 
for all images, particularly if you do not have a scale bar in them. 

 
Copyright Info 

Enter the name(s) of the person(s)/organization who owns the copyright of 
the image or who could give a user of the morphbank system information 
about the image copyright. We strongly recommend that each entry in this 
column is followed either by a morphbank username or an email address in 
parentheses. If a morphbank username is given, the contact info will be 
updated with the morphbank user entry. If a simple email address is given, 
then the information will not be updated. An outdated email address does not 
invalidate the Copyright but it does make it more difficult for a potential 
morphbank web visitor to obtain the appropriate permissions to use the image 
for non-academic purposes.  
Examples: 
Just Name:       John Doe 
Name and morphbank issued user:  John Doe (johndoe) 
Name and standard email address:  John Doe (jdoe@scs.fsu.edu) 
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Image File Name  
Enter the exact name of the image file corresponding to this entry in the 
worksheet. If data entered here is incorrect, it will be impossible for 
morphbank to link the metadata (specimen, locality, etc.) with an image.  Be 
sure what you enter here is accurate. The format should be 
image_name.image_type. Image type can be jpeg, gif, tif, etc. The specified 
file names must exactly match the file names for the images delivered with 
the Excel workbook. Do not leave blanks in the image file name, 
use_underscores to name the images with more intuitive names. Please put 
all images in the same folder. 
 
 
Note:  This worksheet has 250 initialized rows for data.  If more rows are 
needed, see the Additional Notes section of this manual for instruction 
on inserting additional rows. 
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MyView:View:
 
 
The MyView worksheet has 10 columns and consists of two parts. In the first 
section the submitter can choose an existing morphbank view from the drop-down 
list (located in the first column, MyView Name) , the rest of the columns will be 
automatically populated based on the previous choice. Do not change them. If the 
needed view is not provided in the MyView Name list, proceed to the second part 
of this sheet and create the needed views by populating each of the column cells. 
 

  
 

Figure 4 MyView Worksheet Columns A-F 
 
View sequence number  

A number that corresponds to the order of input made in the MyView 
worksheet. This column is auto generated. Do not change it. 
 

My View Name  
Is the first column in the MyView worksheet This column is automatically 
generated. Do not change it. It provides the drop-down list for view name in 
the Image worksheet. The content is a concatenation of View sequence 
number and the Supporting Data worksheet.  

 
 
 



 

Specimen Part  
Enter/choose from the drop-down list the name of the specimen part 
presented by the view. If the specimen part is not in the drop-down list you can 
add it through the Supporting Data worksheet by adding a new entry to the 
Specimen Part column there. 
 

View Angle  
Enter/choose from the drop-down list a description of the view angle that 
corresponds to the view. You can add new values to the drop-down list by 
adding a new entry to the View Angle column in the Supporting Data 
worksheet. 
 

Imaging Technique  
Enter/choose from the drop-down list the imaging technique used for this view. 
If the imaging technique used is not in the list you can add the value by adding 
a new entry to the Imaging Technique column in the Supporting Data 
worksheet. 

 
Preparation Technique 

Enter/choose from the drop-down list the imaging preparation technique used 
for the view. If the image preparation technique used is not in the list you can 
add the value by adding a new entry to the Imaging Preparation Technique 
column in the Supporting Data worksheet.  
 

Developmental Stage  
Enter/choose from the drop-down list the developmental stage of the 
specimen presented in the view. The stage you select should be the same as 
the stage entered in the Specimen worksheet for the specimens in the images 
to which you plan to apply this view. Example: If you enter “adult” as the 
developmental stage for the view, you cannot apply this view to an image of a 
“larva”, if you need to apply a similar view to a larva, you need to create a new 
view entry. 
 

Sex 
Choose one option from the drop-down list. The option you choose should be 
the same as the one you entered in the Sex column in the Specimen 
worksheet for the specimens in the images to which you plan to apply this 
view. You may also choose unknown if the view is applicable to both sexes, in 
which case you can apply the view to images of specimens of any sex. 
 

Form  
Choose one option from the drop-down list. The option you choose should be 
the same as the one you entered in the Form column in the Specimen 
worksheet for the specimens in the images to which you plan to apply this 
view. You may choose indeterminate if the view does not apply to a specific 
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morphological form, in which case you can apply the view to images of 
specimens of any morphological form. 
 

View Applicable to Taxon  
Enter the name of the highest taxon to which this view is applicable. It is 
possible for a view to be applicable outside of the user’s immediate taxon of 
interest.  For example, the view name of lateral habitus, when photographing a 
wasp, is relevant for Insecta but it can also be applied to Arthropoda, 
Hexapoda, and perhaps Animalia.  The user should decide the highest 
possible applicable taxon in which they have confidence that the terminology 
for that view is relevant.  In this case, lateral habitus may be useful as a view 
name through Hexapoda, but may not necessarily apply to images of the side 
view of all animals. This information is required. 

 
 
 

 
Note:  This worksheet has 30 rows for existing views to be chosen and 
200 more for new views to be created.  If more rows are needed, see the 
Additional Notes section of this manual for instructions on inserting 
additional rows. 
 
Be sure not to use the same view twice by only applying a “slight 
change”.  Never change the existing view which was chosen for some 
other image.  The result will affect the upload by omitting some of the 
images that will now appear with invalid views.  If almost the same view 
is needed (even if only one field is different), create a separate view.  
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SpecimenTaxonData: 
 
When adding specimens & images to morphbank, taxon names may need to be 
added to the database. Check the database for names before filling in the 
SpecimenTaxonData worksheet.To add about 50 names or less at the rank 
suborder or lower, it may be more efficient to use the morphbank web-interface 
to add the needed taxon names. *If names need to be added above the suborder 
level, contact mdadmin@scs.fsu.edu to discuss options. When adding large 
numbers of names, at the rank of Genus or lower, the SpecimenTaxonData sheet 
will be efficient. 
 
Ideally, the SpecimenTaxonData worksheet needs to be completed after the 
ImageCollection and Locality worksheets. This worksheet can also be used on its 
own for the purpose of only adding names to morphbank. 
 

 
 

Figure S  Specimen Taxon Data Worksheet Columns A-N 
 
Parentage must be indicated at each rank where the child is new to 
morphbank. When adding a child to parents already in morphbank, one entry for 
that name is sufficient. Columns A – G indicate parentage for the Scientific Name 
given in column H. 
 
Example 1: all the following names except the species are already in morphbank. 
Proteaceae  >   Proteoideae > Beauprea  >  gracilis 
Family   Subfamily  Genus  species 
 
To add the child gracilis to the Genus Beauprea, fill out the Excel Spreadsheet 
as follows: 
 

 
 

Figure S1  Specimen Taxon Data – Add a child 
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Scientific Name String  

Enter the scientific name here as it is to appear in the database.  
 
Taxon Author, Year 

Enter this information (if known) as it is to appear in the database.  
 
Morphbank Publication Id 

In morphbank, log-in > select group > submit > publication. Enter the 
publication data (if known) for the taxon name, click submit, note the 
publication id and enter it in the spreadsheet.  

 
Publication Pages 

If known, enter the page number/s where the name appears in the publication.  
 

Trade Designation Names 
For cultivar purposes, use this field to enter a cultivar's Trade Name. 
  

Nomenclatural Code 
If known, enter the nomenclatural code the taxon name follows such as: ICBN, 
ICZN, ICNCP or other appropriate code. 

 
Source of Original Publication Citation 

If taxon name data is gathered from another database, enter that information 
here such as: TROPICOS, IPNI, uBio, etc. 

 
Example 2: only the Family name is in morphbank, none of the children below. 
Parentage must be indicated at each rank where the child is new to 
morphbank. One row in the worksheet will be needed for adding each new taxa. 
 
Stenocarpus (Subgenus) salignus var. brachycarpus 'Cultivar Name' 
 
In this taxon name example, none of the names are in morphbank. The genus, 
subgenus, species, variety and cultivar will need to be added separately. 

 

 
 

Figure S2  Specimen Taxon Data – Add children 
 
* Note well for Morphbank Publication Id, in the above example, some of the 
publications are already in morphbank. Search publications in morphbank before 
adding one to check for their presence. If they are there, just enter the number in 
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the spreadsheet. It greatly assists the workflow if one adds all the needed 
publications to morphbank before filling out the worksheet. 
 
Names may be added to morphbank without complete publication data. Only 
those names with complete publication data will be sent to ITIS for possible 
inclusion in their database. Please fill in as much data as possible, however, fields 
lettered I – N can be left blank if the data is not available. 
 
Note well (at the moment): cultivar and hybrid names must be added via the 
spreadsheet. Names with regular ranks of form, variety, species, subgenus, 
genus, subtribe, tribe, subfamily, family, and suborder may be added via the web 
interface. If all other parents have been added through the web, only the parent 
and its cultivar child needs entering in the spreadsheet. 
 
If, in the above example, all the names except the cultivar name were added to 
morphbank via the web, the spreadsheet could look like this: 
 

 
 

Figure S3  Specimen Taxon Data –  
Add only cultivar, all parents added to morphbank via web interface 
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Specimen:Specimen:  

 
The Specimen worksheet is associated with the Specimen table in the morphbank 
database. The data entered here should provide information about the specimen 
and the parties involved in the collection of it. This worksheet has 24 columns. 
Below is an explanation of how to populate each one of them. 
 

 
 

Figure 5  Specimen Worksheet Columns A-L 
 
 
Specimen Sequence Number can not be altered 

 
Specimen Sequence Number 

This column is auto-generated.  It is a number that corresponds to the order of 
input made in the Specimen worksheet.  Do not change it. This number will be 
used to make a relation in the workbook between the data for a given 
specimen and the images associated with that specimen.  

 
Scientific Name 

Choose the taxon name for your specimen from the drop-down.  The taxon 
names in this drop-down come from the SpecimenTaxonData worksheet you 
have already filled in. 

 
Basis of Record  

Choose one of the options from the drop-down list. Choices are: Observation, 
Living Organism, Specimen, Germplasm/Seed. If additional options are 
needed, please contact the morphbank admin group mbadmin@scs.fsu.edu. 
The list of options is based on the Darwin Core standard 
http://wiki.tdwg.org/twiki/bin/view/DarwinCore/DarwinCoreDraftStandard

 
Sex  

Choose one of the options from the drop-down list. The list contains a set of 
terms based on community consensus: Male, Female, Hermaphrodite, 
Indeterminate (if the specimen was examined but the sex could not be 
determined), Unknown (if the specimen was not examined for its sex or if the 
sex is not applicable to a particular specimen), Transitional (if the specimen is 
between sexes, like sequential hermaphrodites). If additional options are 

http://wiki.tdwg.org/twiki/bin/view/DarwinCore/DarwinCoreDraftStandard


 

needed, please contact the morphbank admin group mbadmin@scs.fsu.edu. 
The list of options is based on the Darwin Core standard 
http://wiki.tdwg.org/twiki/bin/view/DarwinCore/DarwinCoreDraftStandard
 
 

Developmental Stage  
Enter/choose from the drop-down list the developmental stage of the 
specimen. If the stage that you need to specify is not on the list you can 
update the list by making a new entry in the Developmental Stage column in 
the Supporting Data worksheet. After that, the new stage will appear at the 
end of the drop-down list for Developmental Stage.  

 
Form  

Enter/choose a description of the morphotype of the specimen. Examples: 
queen, worker, exposed. Use “Indeterminate” if you do not wish to apply a 
specific morphotype designation to the specimen. If your specimen is of a 
morphotype that is not part of the drop-down list, you can update the list by 
making a new entry in the Form column in the Supporting Data worksheet. 
After that, the new form will appear at the end of the drop-down list. 
Information about the Supporting Data worksheet is provided at the end of this 
manual. 

 
Preparation Type  

Enter the type of specimen preparation, if applicable. This is the preparation of 
the whole specimen, before incorporation into the collection.  (Examples 
include “Pressed and Dried” and “70% ethanol”.)  

 
Number of Individuals  

Enter the number of individuals that were collected/observed. This is the 
number of individuals in the lot or container representing the specimen record. 

 
Type Status  

Enter/choose from the drop-down list the type status of the specimen. If the 
Type Status you need to specify is not on the list you can update the list by 
making a new entry in the Type Status column in the Supporting Data 
worksheet. After that, the new type status should appear at the end of the list. 
The type status indicates the kind of nomenclatural type that a specimen 
represents. The type status should refer to the name given to the specimen in 
the next few columns. The morphbank system can store any number of 
determinations and type designations for a specimen; contact the morphbank 
admin group if some of your specimens require more than a single type 
designation or determination mbadmin@scs.fsu.edu. 

  
Determined By   

Enter the name(s) of person(s) who determined the taxonomic category of the 
specimen.  Add the names separated by a comma. 
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Date Determined  

Enter the date when the specimen was determined. Use the format: yyyy-mm-
dd. If the day is unknown enter yyyy-mm-00, or if the month is unknown enter 
yyyy-00-00. (Make sure the date is current or a past date.) 
 

Determination Notes  
Enter any notes related to the determination of the specimen. 
 

 
 

Figure 6 Specimen Worksheet Columns M-X 
 
Institution Code 

Enter the code for the institution to which the collection belongs.  
 
Collection Code  

Enter a unique alphanumeric value which identifies the collection to which the 
specimen belongs. Make sure that all codes used in this column are also given 
on the Image Collection worksheet together with the full name and address of 
the collections.   
 

Catalog Number  
Enter a unique alphanumeric value which identifies the specimen record within 
the collection. It is recommended that this value provides a key by which the 
actual specimen can be identified. If a biological specimen (individual 
organism) is represented by several collection items, for instance representing 
various types of preparation, this value should identify the individual collection 
item.   

 
Previous Catalog Number  

Enter a previous catalogue number if the specimen was earlier identified by 
another catalog number in the current catalog or at/in another 
institution/catalog. A fully qualified catalog number is preceded by Institution 
Code and Collection Code with a space separating each sub element. 
Referencing a previous catalog number does not imply that a record for the 
referenced item is or is not present in the corresponding catalog, or even that 
the referenced catalog still exists.  (This category pertains mainly to museums 
or personal collections.) 
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Related Catalog Item  
Enter a fully qualified identifier of a related catalog item (a reference to another 
specimen). A fully qualified identifier consists of Institution Code, Collection 
Code and Catalog Number, with a space separating each of the three sub 
elements.   
 

Relationship Type  
Enter a string (named value) that specifies the relationship between the 
specimen and the related catalog item. Example of possible values include: 
“parasite of”, “epiphyte on”, “progeny of” etc.   
 

Collection Number  
Enter an identifying number (a string) which was applied to the specimen at 
the time of collection/observation. This number links different 
parts/preparations of a single specimen and field notes with the specimen.   
 

Collector’s Name  
Enter the name(s) of the collector(s) responsible for collection of the specimen 
or taking the observation. This column has to be populated, no blanks are 
recommended.  Separate each collector’s name with a comma.  (Example: 
John Smith, Jane Doe).  

 
Date Collected  

Enter the date when the specimen was collected. The date format should be 
yyyy-mm-dd. If the day is unknown enter yyyy-mm-00 or if the month is 
unknown enter yyyy-00-00. 

 
Locality  

Enter the locality from which the specimen was collected. This column is a 
drop-down list that corresponds to the data entered in the Locality worksheet. 
Each item in the drop-down list contains the locality sequence number 
followed by the locality description. To populate this column, first enter the 
data in the Locality worksheet and then choose the appropriate option from 
the drop-down list.   
 

Notes  
Enter additional text notes related to the specimen record.  (Specimen notes 
might  include voucher label information (i.e. DNA, anatomical, etc.) about a 
specimen or other information such as the duration of the collection/trapping 
sessions noting a range of dates the process took place.) 

 
Specimen Description  

This column is auto generated. Do not change it. It is used to provide the drop-
down list in the Image worksheet and to make the link between images and 
associated specimens. The field is a concatenation of specimen sequence 
number / genus /species /sex /date collected /locality. 
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Note:  This worksheet has 250 initialized rows for data.  If more rows are 
needed, see the Additional Notes section of this manual for instructions 
on inserting additional rows. 
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LLooccaalliittyy::  

 
After entering the Image Collection data proceed to the Locality tab and 
accurately fill in all the fields.  These fields are linked to fields in other tabs 
so you will only have to enter unique locality data once.  Taking the time to 
do this accurately here will reduce errors and conflicts later on.  Make sure 
data for locality coordinates are in the decimal form given in the examples 
for Latitude and Longitude in this section. The Locality worksheet should 
contain detailed information about the localities where the specimens were 
collected. The information entered in this worksheet provides the drop- 
down list in the Specimen worksheet.  Explanation of how to populate each 
of its 14 columns is provided below.  
 

  
 
 Locality Sequence Number can not be altered 

 
Figure 7 Locality Worksheet Columns A-F 

 
 
Locality sequence number  

A number that corresponds to the order of input made in the Locality 
worksheet. This column is auto-generated. Do not change it. 

 
Continent Ocean  

Choose the continent or ocean where the specimen was collected from the 
drop-down list.  If you need to enter a continent/ocean not provided in the list 
you can make a new entry in the ContinentOcean column in the Supporting 
Data worksheet. After this, the new entry should appear at the end of the list. 

 
Country  

Choose one country /political unit from where the specimen was collected. The 
drop-down list contains names of currently recognized countries. If you need 
to add new entries to this list, please contact the morphbank admin group 
mbadmin@scs.fsu.edu. For old specimens, we recommend that the original 



 

country of collection, if applicable, is added to the Locality Description column 
and that the Country column is used to provide the current political unit for the 
locality, if this is possible to determine. 
 

Locality Description  
Enter the name of the Region/Province/County/Place and displacement from 
this name (if applicable) from which the specimen was collected.  Examples: 
“FL Tallahassee, Apalachicola National Forest”, “FL St George Island”. The 
locality description should correspond to label data if possible. 
 

Latitude  
Enter the latitude of the locality. Use the decimal format followed by the letter 
N (for north) or S (for south). Convert minutes and seconds to a decimal part, 
if applicable. The number entered should be between 0.0000 and 90.0000.  
There are conversion websites available that convert degrees to decimal.  
(One such site is http://www.jeeep.com/details/coord/). 
 

Longitude  
Enter the longitude of the locality. Use the decimal format followed by the letter 
W (for west) or E (for east). Convert minutes and seconds to a decimal part, if 
applicable. The number entered should be between 0.0000 and 180.0000.  
There are conversion websites available that convert degrees to decimal.  
(One such site is http://www.jeeep.com/details/coord/). 
 

 
 

 
 
Locality Name can not be altered 

 
Figure 8 Locality Worksheet Columns G-M 

 
 
Coordinate Precision  

Enter an estimate of how tightly the longitude and latitude of the collecting 
locality was specified. Express the precision as a distance, in meters, that 
corresponds to a radius around the latitude-longitude coordinates. Leave the 
field blank if the precision is unknown, can not be established or is not 
applicable.  
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Minimum Elevation  
Enter the minimum elevation of the locality in meters above (positive) or below 
(negative) sea level. 

 
Maximum Elevation  

Enter the maximum elevation of the locality in meters above (positive) or 
below (negative) sea level. 
 

Minimum Depth  
Enter the minimum depth of the locality in meters below the surface of the 
water where the collection was made. All material collected for this specimen 
record should be at least this deep. Use positive number for below the surface 
and negative for above.  

  
Maximum Depth   

Enter the maximum depth of the locality in meters below the surface of the 
water where the collection was made. All material collected for this specimen 
record should be at most this deep. Use positive number for below the surface 
and negative for above. 

 
Locality Name  

This column is auto generated. Do not change it. The content of it is a 
concatenation of locality sequence number and locality description. This 
column is made for easy look up of localities in the Specimen work sheet. 
 

Information Withheld 
This column needs to be populated only when locality data is withheld. You 
need to provide a reason for withholding information (example: endangered 
species) and a contact person who has the authority to release this 
information to a given group of users. 
 
 
Note:  This worksheet has 250 initialized rows for data.  If more rows are 
needed, see the Additional Notes section of this manual for instructions 
on inserting additional rows. 
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EExxtteerrnnaall  LLiinnkkss::  
 
The External links worksheet is optional and should be populated last.    Use this 
option to link the deposited images to any external link and link any site back to 
morphbank. Links may include other databases, NCBI accession numbers, 
location maps etc. Links may be associated with any morphbank table, so they 
can appear in the SpecimenRecord, ImageRecord, LocationRecord or 
ViewRecord tables. This worksheet has 5 columns which are described below. 
 
 

 
Figure 9 External Links 

 
 
Object Type 

Choose from the drop-down list the Object Type for which you want to create 
a link. The choices are:  Specimen, View, Image and Locality. Note well: if 
the same institution and/or project link is to be added to all the Specimens 
and Images, that can be done with the first worksheet, Image Collection. This 
External Links worksheet allows unique links to specific objects. 

 
Type Description for External Link 

Choose from the drop-down list the Type Description for External Link.  The 
choices in this column will change to match the Object type selected.  For 
example:  If an Object Type of Specimen, View or Locality is selected, the 
Type Description choices will contain the description field from that 
associated worksheet (Specimen-will contain the description field from the 
Specimen Worksheet, View-will contain the description field from the View 
Worksheet etc.) .If an Object Type of Image is selected, the Type Description 
choice will be the image_file name . 

 
Type of External Link 

Choose the Type of External Link from the drop-down list.   The  choices are 
Google map for Locality object and GenBank for Specimen object. For adding 
new types of external links like University collections, refer to the Supporting 
Data worksheet and add the desired entry. 

 



 

Label for External Link 
Type in a short descriptive label.  This field is required.  The label will be the 
name of the link that appears on the morphbank record page. Appropriate 
labels would include the name of the institution that the link is going back to or 
the name of the gene region that is linking to an accession number.  
Examples: Google Map, CO1, AMNH.  Make sure the label is brief. 

 
External Link 

Provide the exact name of the external link (URL). The accuracy of the 
provided data will be crucial for a proper linking from/to morphbank.  Users 
are responsible for maintaining there own links i.e. replacing, updating, or 
correcting outdated, incorrect or otherwise broken links.  This can be done 
through the morphbank web interface (Edit/External Links) after the images 
are uploaded to morphbank. 

 
External Link Notes: 

This is a free text entry to further describe the usage of the link.  An example 
would be to make a comment about an institution that is being linked to.  

 
 
NOTE: Be sure to have an object created before adding an external link. If 
any changes are made to the spread sheet, it is necessary to re-choose the 
description to which the external link is associated with.    
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Supporting  Data:Supporting Data:
 
 
The Supporting Data worksheet provides the data for the dropdown lists that can 
be updated: Specimen Part, View Angle, Preparation Technique, Imaging 
Technique, ContinentOcean, Developmental Stage, Form, Type Status and Type 
of External Link. Each of the columns can be updated by just entering the desired 
value in the first empty cell of that column.  
 

Figure 10 Supporting Data Worksheet Columns A-D 
 

 
 

Figure 11 Supporting Data Worksheet Columns D-H 
 
Only a limited number of extra entries can be made in the worksheet without any 
changes. For Specimen Part there are 100 initialized cells for extra entries, for all 
other columns there are 20 cells for extra entries. If you need to add more than 
the pre-formatted number of extra cells, it is necessary to make the newly 
entered data accessible so the values show up as drop-down selection options 
on the appropriate worksheet ( Please feel free to contact mbadmin@scs.fsu.edu 



 

for help in this process).  To make them accessible you need to follow this 
procedure: 
 
Make accessible 
 
• From the top menu choose Insert>Name>Define (Fig. 13).  

 

 
Figure 12 Adding extra cells 

 
• In the Define Name window, select the column name from the worksheet 

where the extra data was/will be entered.  If new rows are needed for 
Specimen Part, select that name from the list. (Fig. 14) . 

 
• At the bottom of the Define Name window there is a field called Refers to; 

There will be a string of characters that look something like: 
=SupportingData!$A:$2:$A$101.   

 

 
Figure 13 Define Name 
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2. Provide the name of your directory/repository from where we can directly 

download mBdet.xls and the corresponding images. You should also set a 
time slot of when we can do the file transfer. Be aware that during this 
time slot your data will be publicly accessible. 

 
3.  Morphbank provides a secure ftp upload service as an alternative to 

mailing CDs/DVDs.  Registered morphbank users may email 
mbadmin@scs.fsu.edu for an ftp upload password, username and 
address.  Although you should be familiar with ftp, only minimal 
experience is necessary to use this service.  The morphbank server may 
be accessed by using secure shell terminal, command line or any graphic 
ftp program.  

 
Once a morphbank administrator has sent account information, users may 
begin uploading. Be sure to use ftp (file transfer protocol), not sftp 
(simple file transfer protocol which is a mail transfer protocol for 
email messages) as the transfer protocol. There is no limit on the number 
of files uploaded at one time.  Once the images are on the server, notify 
mbadmin@scs.fsu.edu of the completion; include a message requesting 
that the account remain open if needed. If the account is not requested to 
remain open, morphbank will delete the files off the server once they have 
been received and the account password changed.   

 
This service may be used once or many times depending on the users 
specific needs.   
 
Note:  If errors are found within your Excel workbook they will be 
commented and the workbook will be returned for corrections.  
Please include a business hours phone number so one of the 
morphbank team can contact you if needed. 

 
AAddddiittiioonnaall  NNootteess::  
  
 
Inserting new rows into the worksheets: 
 
The Specimen, Locality and Image worksheets have 250 initialized rows while 
MyView has 30 rows to be populated from a drop-down list and 200 rows for 
creating new views. If you need to add more entries for auto generated columns, 
columns that reference columns from other sheets and display drop-down list, 
follow this procedure: 
  
Images Worksheet: If more than 250 images are to be entered, the user will 
need to add more initialized rows to the images worksheet.   
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Add new rows: 
 

• Select all of the cells in the last auto generated row (last row that can contain 
data) by clicking on the cell in column “A” of the last initialized row and 
dragging to column “F” of that row.  The row will now be highlighted.  (Fig. 16) 

 

 
Figure 15 Highlight the Last Row of Cells 

 
• Move the mouse to the right lower corner of that last cell of the row you just 

selected (where the dot is). The cursor will be shaped like a Plus “+” sign. 
 
• Click on the dot and drag the cursor down the number of rows you wish to 

add.  
• Select Copy Cells option from the drop-down menu (Fig. 17).   

 
 
 
 

 
 
 
 
 
 
 

Figure 16 Click on indicated symbol to reveal drop-down list 
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• If there was information in the last auto generated row, that information has 
been copied to the new rows.  You can write over the information or delete it. 
To delete, select and drag over all the rows and columns with the unwanted 
information to highlight them (Do not highlight and delete column A, Image 
Sequence Number) and select “delete” on the keyboard. 

 
Figure 17 Newly Generated Rows 251-255 

 
 
 

Specimen, Locality and MyView Worksheets: 
 

If adding more than 250 specimens or localities or more than 200 extra views, 
the user will need to insert more initialized rows to the appropriate worksheet.  
The process will include adding new rows and then making sure the new 
information in those rows is accessible by the other worksheets.   

 
Add new rows: 

Follow the instructions above for adding new rows to the images 
worksheet.  The results will look something like fig. 19.  It is important 
now to make the new row accessible. 

 

 
Figure 18 Ten New Rows Added to the MyView Worksheet (Only Columns F-J Showing) 
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Make accessible: 
 

The drop-down menus on other 
worksheets use the information in 
the auto-generated column (last 
column) on the Specimen 
(Specimen Description), Locality 
(Locality Name) or MyView (View 
Name) worksheets to supply 
information to other worksheet 
drop-down lists.  It is necessary to 
make the newly generated rows 
accessible so the values show up 
as drop-down selection options on 
the appropriate worksheet.  
  
 
 

Figure 19 Top of Page Menu Insert>Name>Define 
 

• From the top menu choose Insert>Name>Define (Fig.20). 
 
• In the Define Name window, select the auto-generated column 
name from the worksheet where the new rows where generated.  If new 
rows were added to the Specimen worksheet select SpecimenDescription.  
If new rows were added to the Locality worksheet select LocalityName. If 
new rows were added to the MyView worksheet select ViewName (Fig 21) 
. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20 Define Name Menu 
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• At the bottom of the Define Name window there is a field called 
Refers to; There will be a string of characters that look something 
like:=View!$2:$J$301.  This indicates that the name ViewName is 
associated with column J row 2 through column j row 301 of the MyView 
worksheet.  Alter the last number in this string to reflect the value of the 
last row that was added.  For example, if you added 10 new rows the 
string would look like: =View!$2:$J$311 (Fig. 22). 

 
• Once the number string has been changed to reflect the newly 
generated rows, select the OK button and close. 

 
 

 
Figure 21 The Definition Changed to Reflect the 10 New Rows 
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Contact Information: 

 
 

Questions or Comments 
Admin Group 
mbadmin@scs.fsu.edu
 
Karolina Maneva-Jakimoska   
maneva@scs.fsu.edu
 

Contacts 
Admin Group 
mbadmin@scs.fsu.edu
 

Land Mail Address 
morphbank Admin Group  
c/o Karolina Maneva-Jakimoska 
Mail Code 4120 
Florida State University 
Tallahassee, FL  32306-4120 
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